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About this Guide

Audience and Purpose
This guide is for Siebel CRM administrators who plan to install the D&B360 software application in their
CRM environment.

We assume that you are familiar with how to use a command-line interface and how to download and copy
executable files to your local directory.

If you are interested in more training and education about using our products, learning opportunities are
available here: D&B Training and Education Opportunities for Admin Users.

Conventions

Note: Notes mean reader take note and provide helpful suggestions.

(!) Important Note: Important Notes mean reader be careful. In this situation, you might do something that
could result in loss of data.

In sections that include instructions for using the D&B360 and CRM graphical user interface (GUI):

l Text in bold indicates the name of a window, tab, field, area, or button that you click or interact with.

l Text in monospace indicates a directory path or a command that you need to type in the command-line
interface.

Navigating in the PDF

Note: To download the free, latest version of Adobe Reader, go to this web site:
http://get.adobe.com/reader/.

1. To return to the page you were on after you click a cross reference link, press Alt + Left Arrow.

2. To return to the first page of the document, press the Shift + Home.

http://www.clicktools.com/survey?iv=3a124b4a09708f4&q9=D%26B360%20Salesforce%20Admin|D%26B360%20SAP%20Admin|D%26B360%20Microsoft%20Admin|D%26B360%20Siebel%20Admin|D%26B360%20Oracle%20Admin
http://www.clicktools.com/survey?iv=3a124b4a09708f4&q9=D%26B360%20Salesforce%20Admin|D%26B360%20SAP%20Admin|D%26B360%20Microsoft%20Admin|D%26B360%20Siebel%20Admin|D%26B360%20Oracle%20Admin
http://www.clicktools.com/survey?iv=3a124b4a09708f4&q9=D%26B360%20Salesforce%20Admin|D%26B360%20SAP%20Admin|D%26B360%20Microsoft%20Admin|D%26B360%20Siebel%20Admin|D%26B360%20Oracle%20Admin
http://www.clicktools.com/survey?iv=3a124b4a09708f4&q9=D%26B360%20Salesforce%20Admin|D%26B360%20SAP%20Admin|D%26B360%20Microsoft%20Admin|D%26B360%20Siebel%20Admin|D%26B360%20Oracle%20Admin
http://www.clicktools.com/survey?iv=3a124b4a09708f4&q9=D%26B360%20Salesforce%20Admin|D%26B360%20SAP%20Admin|D%26B360%20Microsoft%20Admin|D%26B360%20Siebel%20Admin|D%26B360%20Oracle%20Admin
http://www.clicktools.com/survey?iv=3a124b4a09708f4&q9=D%26B360%20Salesforce%20Admin|D%26B360%20SAP%20Admin|D%26B360%20Microsoft%20Admin|D%26B360%20Siebel%20Admin|D%26B360%20Oracle%20Admin
http://www.clicktools.com/survey?iv=3a124b4a09708f4&q9=D%26B360%20Salesforce%20Admin|D%26B360%20SAP%20Admin|D%26B360%20Microsoft%20Admin|D%26B360%20Siebel%20Admin|D%26B360%20Oracle%20Admin
http://www.clicktools.com/survey?iv=3a124b4a09708f4&q9=D%26B360%20Salesforce%20Admin|D%26B360%20SAP%20Admin|D%26B360%20Microsoft%20Admin|D%26B360%20Siebel%20Admin|D%26B360%20Oracle%20Admin
http://get.adobe.com/reader/


3. To navigate in the PDF file or change the Adobe Reader settings, on the Adobe Reader menu,
select View > Page Navigation, Page Display, and Zoom.

Related Documentation
For more information about D&B360 from the user perspective, refer to the D&B360 User Guide. For more
information about using the Siebel CRM, refer to the CRM documentation.

D&B360 Administration and Installation Guide for Siebel CRM About this Guide
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Chapter 1: Introduction
Welcome to the D&B360 Administration and Installation Guide, which instantly connects you to customer and
prospective customer data that only D&B can provide – plus relevant rest-of-world content, all within your
instance of Siebel CRM. 

Product Benefits 1-1

Guide Objectives 1-2

Guide Organization 1-2

Access to Features 1-2

Product Benefits
With D&B360, you get the business insight you need, the D&B data quality you want, and the ease-of-use you
deserve.

Now you can see all angles of your prospects and customers within your CRM:

• Know your customers better.

• Acquire new prospects.

• Sell deeper into organizations.

• Improve salesperson effectiveness.

D&B empowers you with relevant and credible information, facilitating your role as a trusted advisor to enable
new sales.



SEE NEW OPPORTUNITIES Seeing your customers and prospects in a new way can uncover new information and
new-sale entry points.

ACCELERATE YOUR SALES CYCLE Once you establish relevance and credibility, customers will trust you with their
business.

EXPAND YOUR CUSTOMER
FOOTPRINT

Build customer relationships on a foundation that is based on relevance, credibility,
and trust.

POSITION YOUR SUCCESS

With D&B360, you have a powerful tool that helps you to better understand
your customers pain points, respond to their needs, and ultimately
positions you to win more business.

The D&B360 platform features On-demand access to D&B data, automatic
refresh and synchronization with the D&B database, and seamless
integration of rest-of-world data.

Guide Objectives
The D&B360 Administration and Installation Guidefor Siebel CRM provides instructions for general D&B360
Administrator tasks.

Guide Organization
The D&B360 Administration and Installation Guide is organized by tasks groups, which are presented in the
sequence in which they occur. For instance, you need to consider the pre-installation requirements before you
can install or upgrade the product. Likewise, you need to install the product before you can configure profiles or
deploy the application.

Access to Features

D&B360 is a powerful tool. You might find more than one way to do a specific task and learn that you can use a
feature or function in more than one area.

For that reason, this guide is organized by functions or tasks you are trying to accomplish. References to links or
menu options that help you navigate your CRM are also included.

D&B360 Administration and Installation Guide for Siebel CRM Chapter 1: Introduction
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Chapter 2: Getting Started
About D&B360 2-1

Considerations for Administrators 2-2

Required Siebel User Interface Mode 2-2

User Access Level 2-2

Back Up Your Data 2-2

D&B360 Packages 2-3

File Contents 2-4

Using Rest of World 2-8

Rest of World Applications 2-9

Setting Alerts 2-10

Note: For more information about the user interface and other features of theSiebel CRM, refer the user,
getting started, installation, and administrator guides for that CRM.

About D&B360
To find basic information and useful links for interacting with D&B360, click About D&B360, located on the
D&B360 menu. You will also find a link to the D&B training web sites here.



Considerations for Administrators
You will be working within Siebel CRM to establish the settings that you need. Take time to familiarize yourself
with Siebel operations and the location of the Siebel CRM documentation. This information will help you
successfully complete tasks as an administrator for D&B360 for Siebel CRM.

Required Siebel User Interface Mode

Siebel has two user interface modes: High Interactivity (HI) and Standard Interactivity (SI). The main differences
between the two modes are how users access the features and which browser they use.

High interactivity l Navigation is located below the D&B360 tab as links

l Must run using proper settings on an IE 7 or 8 browser

Standard Interactivity l Navigation is located in the top left menu

l Can run on both IE and Firefox 3.6

User Access Level

To access D&B360, we recommend that users are assigned an SSE role.

Back Up Your Data

We highly recommend that you back up your data before you install D&B360. For more information, see:

http://download.oracle.com/docs/cd/E14004_01/books/AppDeployMgr/AppDeployMgr_DeployPkg13.html

D&B360 Administration and Installation Guide for Siebel CRM Chapter 2: Getting Started
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D&B360 Packages
D&B360 is currently available in three packages:  Tier 1, Tier 2 and Tier 3. The following table provides an
overview of what is available in each package.

Location and Feature Tier 1 Tier 2 Tier 3

COMPANY

Ø Company Matching ü ü ü

Ø Company Data

Ø Ø D&B360+ — (76 fields) ü ü ü

Ø Ø D&B360+ — (100 fields) not available ü ü

Ø Ø D&B360 View — (Related Accounts) not available ü ü

Ø Ø D&B360 View — (Family Tree Query) not available not available ü

Ø Ø D&B360 View — (Family Tree Hierarchy) not available not available ü

Ø Ø D&B360 Marketing Prescreen — (Accounts) not available ü ü

Ø Ø D&B Competitors — (Accounts) not available not available ü

Ø Ø D&B Industries powered by First Research — (Accounts) not available not available ü

Ø Ø D&B Financial — (Accounts) not available not available ü

Ø D&B360 Account Refresh — (Accounts) ü ü ü

CONTACTS

Ø Ø Contact Search — (including Contact Name Search) ü ü ü

Ø Ø Contact Append with smart append & merge ü ü ü

REST OF WORLD (Companies and Contacts)

Ø Ø Favorites ü ü ü

Ø Ø Alerts ü ü ü

Ø Ø News ü ü ü

Ø Ø Finance ü ü ü

Ø Ø Map ü ü ü

Dun & Bradstreet © 2013 2-3
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Location and Feature Tier 1 Tier 2 Tier 3

Ø Ø YouTube ü ü ü

Ø Ø Blogs ü ü ü

Ø Ø Facebook ü ü ü

Ø Ø Twitter ü ü ü

Ø Ø LinkedIn ü ü ü

Ø Ø Skype ü ü ü

D&B360 BUILD A LIST

Ø Ø D&B360 Build-A-List ü ü ü

Ø Ø D&B360 Look-A-Like not available ü ü

D&B INDUSTRIES POWERED BY FIRST RESEARCH

Ø Ø D&B Industry Search not available not available ü

Note: Not all features and content are available in all packages.  If you have questions, contact your D&B
sales representative.

File Contents
The zipped file that you downloaded from the D&B360 Registration site includes all of the software you need to
add the value of D&B360 to your company’s CRM system. Ensure that your file contains the following:

D&B360 Administration and Installation Guide for Siebel CRM Chapter 2: Getting Started
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Folder Contents

Dnb1 Repository folder:

(1) Table ACCOUNTXT.sif

(2) Table ACCOUNTXT_des.xml

(3) TABLE CCODE.sif

(4) TABLE CCODE_des

(5) TABLE DNBADMIN.sif

(6) TABLE DNBADMIN_des.xml

(7) TABLE DNBCODE.sif

(8) TABLE DNBCODE_des.xml

(9) TABLE DNBCOMPANY.sif

(10) TABLE DNBCOMPANY_des.xml

(11) TABLE DNBCONTACT.sif

(12) TABLE DNBCONTACT_des.xml

Dun & Bradstreet © 2013 2-5
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Dnb2 Repository folder:

(1) TABLE DNBCOMPANYXR.sif

(2) TABLE DNBCOMPANYXR_des.xml

(3) TABLE DNBCONTACTXR.sif

(4) TABLE DNBCONTACTXR _des.xml

(5) TABLE DNBOPPTY2XR.sif

(6) TABLE DNBOPPTY2XR_des.xml

(7) TABLE DNBOPPTYXR.sif

(8) TABLE DNBOPPTYXR _des.xml

D&B360 Administration and Installation Guide for Siebel CRM Chapter 2: Getting Started
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Dnb3 Repository folder:

(1) 10IO.sif

(2) 10IO_des.xml

(3) Applets.sif

(4) Applets_des.xml

(5) BC.sif

(6) BC_des.xml

(7) BO.sif

(8) BO_des.xml

(9) BS.sif

(10) BS_des.xml

(11) Links.sif

(12) Links_des.xml

(13) Screens.sif

(14) Screens_des.xml

(15) Views.sif

(16) Views_des.xml
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Dnb4 Repository folder:

(1) 11Workflows.sif

(2) 11Workflows_des.xml

Database folder:

(1) 1-1HHPP_View.sif

(2) 1-1HHPP_View _des.xml

Dnb5 Repository folder:

(1) 1-1HHQ5_Responsibility.xml

(2) 1-1HHQ5_Responsibility_des.xml

(3) 1-24NF_Symbolic_URL.xml

(4) 1-24NF_Symbolic_URL_des.xml

(5) 1-28T6P_EAI_Data_Map.xml

(6) 1-28T6P_EAI_Data_Map_des.xml

(7) 1-29QAD_Web_Service_-_Inbound.xml

(8) 1-29QAD_Web_Service_-_Inbound_des.xml

Using Rest of World
Rest ofWorld, or ROW, refers to social media applications and news feeds about the companies you are
interested in. These applications interact with your CRM and D&B360 to provide useful information related to
D&B360 data. D&B360 ROW applications display as follows:

By linking to ROW applications in D&B360, you can get a fully aggregated information view of your customers
from several social and news media sources — all within your CRM application.

D&B360 Administration and Installation Guide for Siebel CRM Chapter 2: Getting Started
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Rest of World Applications
D&B360 currently supports the social and news media applications listed in the following table. From a D&B360
Account page, click D&B360 ROW to display the ROW tabs. To navigate through the ROW applications, click the
tabs.

ROW Icons Description

Allows you to save items of interest to you and stores them in this tab.

To add an item as a favorite, such as a news story, click the Star icon.
When you see your cursor pointer change into a little hand, click Mark as a
Favorite.

Allows you to track news so you can create customized alerts targeted to
your specific areas of interest. These e-mail alerts include relevant news
articles, press releases, company Web site updates, and blog posts, and are
delivered overnight to your email in-box. Use alerts to stay up-to-date about
the most recent company news, reach out to prospects or customers, create
sales opportunities, and follow events of both public and private
companies. For more information, see "Setting Alerts" on page 2-10

Displays aggregated headlines from many of the world's news sources. In
D&B360, the News tab displays overall news about the account name with
links to related articles. To open an article, click its link.

Displays stock feeds and financial news feeds about a company from a
variety of sources.

The Map icon pre-populates the Account Billing address and connects to
Google Maps to show the address location.

YouTube is a video-sharing website where users can upload, share, and
view videos. A list of YouTube videos displays from companies in your
D&B360 accounts. Only company-authorized videos display.

Blogs display a list of authorized blogs from companies in your D&B360
accounts.

Dun & Bradstreet © 2013 2-9
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Facebook is a social utility that facilitates communication. Only company
authorized Facebook pages display for each company. To view Facebook
information about people and companies from within D&B360, you need to
have a Facebook account.

A Facebook window opens to the account page you are currently viewing if
it exists in the database. To view the company Facebook information, if you
are not already logged in to Facebook, log in to your Facebook account.

Twitter operates a free digital service site that blends social networking with
the ability to post short messages (or micro-blogs) limited to 140 characters
or less, commonly known by users as Tweets. The Twitter service is
designed for use on personal computers and through mobile devices such
as smart phones. Tweets are published on a poster's personal web page,
and can be restricted to select viewers, or viewed by anyone.

In D&B360, when you click the Twitter tab, a list of that company's official
tweets displays.

LinkedIn is a business-oriented social networking site where you can
connect with trusted contacts and exchange knowledge, ideas, and
opportunities.

If you are not already logged in to LinkedIn, you will need to log in when it
opens in a browser window. If the account you are viewing is in the
database, a LinkedIn window for that company opens. If that company is
not found, a LinkedIn search window opens with that company name pre-
populated. Or you can use the LinkedIn search window to define your
search.

Click to make voice calls over the Internet. If you have Skype installed in on
your computer, you can use the Skype icon listed next to phone number to
make a Skype call. If phone numbers for companies, contacts, or
leads/opportunities are in your D&B360 account information, you can
make Skype calls to them.

Setting Alerts

1. When you click the Alerts tab for the first time, in the eMail Address field that displays, type the email
address where you want your alerts digest email to be sent.

2. Click Subscribe.

D&B360 Administration and Installation Guide for Siebel CRM Chapter 2: Getting Started

2-10 Dun & Bradstreet © 2013



3. Click Alerts.

4. Select which type of alerts you are interested in, or click Select All.

5. ClickMonitor.
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Chapter 3: Preparing Deployment Packages
Copying Folders from the Zipped File 3-1

Creating Descriptor Files 3-2

Moving Packages to the Default Package Directory 3-5

Copying Folders from the Zipped File
1. In your C:\ directory, create a new folder and name it export.



2. From the zipped file you downloaded (see "File Contents" on page 2-4), copy the DnB1, DnB2, DnB3, DnB4
and DnB5 folders to your C:\export directory.

Creating Descriptor Files
1. In your Windows Start menu command prompt, type cmd.

2. In the Run window Open field, to change the directory to the management server directory, type
C:\sba81\siebsrvr\mgmtsrvr, then click OK.

Note: Your directory path might be different depending on your Siebel Installation.

D&B360 Administration and Installation Guide for Siebel CRM Chapter 3: Preparing Deployment Packages
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Your command window might look like this:

4. Return to the command prompt and type the following commands:

l admpkgr generate C:\export\DnB1

l admpkgr generate C:\export\DnB2

l admpkgr generate C:\export\DnB3

l admpkgr generate C:\export\DnB4

l admpkgr generate C:\export\DnB5

Dun & Bradstreet © 2013 3-3
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These commands create the package descriptor files, which are a manifest of the customizations in the
packages. After you execute these commands, they should complete with 0 errors and 0 warnings.
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Moving Packages to the Default Package Directory

Before your packages are ready for deployment, you need to move them to the default package directory.

l From your C:\export directory, copy the following directories to
C:\sba81\siebsrvr\mgmtsrvr\adm\packages.

l DnB1
l DnB2

l DnB3

l DnB4

l DnB5

Your path might be different depending on your Siebel Installation.

Dun & Bradstreet © 2013 3-5
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Chapter 4: Deploying D&B Packages
Initiating Package Deployment for DnB1, DnB2, and DnB3 4-1

Locating and Validating the Enterprise Server 4-2

Processing DnB1, DnB2, DnB3 Packages 4-4

Compiling the Application 4-6

Processing the DnB4 and DnB5 Packages 4-9

Applying Table Changes 4-11

Adding the D&B360 Window to the Application 4-12

Initiating Package Deployment for DnB1, DnB2, and DnB3
You must configure a command prompt path that includes the management server’s executables directories. An
alternative is to edit the global PATH environment variable, but this would affect all command prompts.

1. If you closed the command window, in your Windows Start menu, type run.

2. At the command prompt, type cmd.

3. To add the management server’s bin directory to the PATH environment variable, type this command:

set PATH=C:\sba81\siebsrvr\mgmtsrvr\bin;%PATH%

Note: Your directory path might be different depending on your Siebel Installation.



4. To change to the management server directory, type cd C:\sba81\siebsrvr\mgmtsrvr.

Locating and Validating the Enterprise Server

To locate the Enterprise Server, complete the steps in the section that immediately follows. If you do not need
these instructions, skip to the see "Validating the Enterprise Profile File" on page 4-4.

Locating the Enterprise Server

1. To search for Administration - Server Management, click the site map icon.

2. In the Web Services window, click Administration - Server Management.

D&B360 Administration and Installation Guide for Siebel CRM Chapter 4: Deploying D&B Packages
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3. In the Enterprise Server window, Administration - Server Management area, click Enterprises.

The Enterprise Servers window opens. In our example, the Siebel enterprise server is named OUEnt7.

Dun & Bradstreet © 2013 4-3
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Validating the Enterprise Profile File

In the command line, type the following command:

deploy_OUEnt valent SADMIN SADMIN

where:

This … is …
Your CRM Enterprise Server QUEnt
Your User Name 1st SADMIN
Your Password 2nd SADMIN

Note: If you have another CRM Enterprise Server Name, you can change QUEnt to your enterprise name.

SADMIN is the default user administrator for Siebel, but you can change this name. Any user name you
replace with must have the SSE role.

This validation should succeed without errors.

Processing DnB1, DnB2, DnB3 Packages
Complete the steps in this section for each of the first 3 packages — DnB1, DnB2, and DnB3 — one at a time. In
the following illustration, the steps in darker blue are mandatory. The steps in lighter blue are optional but highly
recommended because a data integrity link is associated with them.

D&B360 Administration and Installation Guide for Siebel CRM Chapter 4: Deploying D&B Packages
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For these steps, we use QUEnt as the CRM enterprise server name and SADMIN as the user name and
password. When you complete these steps, substitute any revised names you used (see "Locating and
Validating the Enterprise Server" on page 4-2).

1. To load package references and verify the load, in the command line, type this command: this is the step
based on paragraph style that Lori helped me set up.

deploy_OUEnt load SADMIN SADMIN DnB1

After a few seconds, a message displays to inform you that this command executed successfully.

2. To create a deployment session for your package and check the status of the session, type this command:

deploy_OUEnt create SADMIN SADMIN DnB1

This command creates a deployment record in the database in preparation for the data migration.

After a few seconds, a message displays to inform you that this command executed successfully.

Note: The next two steps are optional. However, it is strongly recommended that you complete
these steps before deploying your package.

3. (Optional): To validate the target enterprise, type this command:

deploy_OUEnt validate SADMIN SADMIN DnB1

This process takes about two minutes. Although this step is optional, it is strongly recommended, as it
verifies schema versions and that the target agents are online. Verify that the validation succeeds.
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4. (Optional): To back up data that will be affected, type this command:

deploy_OUEnt backup SADMIN SADMIN DnB1

Note: Although this backup should run automatically when you enter the copy command, doing it
here ensures that the backup exists and decreases the time required for the copy command.

5. To deploy the customizations to the target enterprise, type this command:

deploy_OUEnt copy SADMIN SADMIN DnB1

After a few minutes, a message displays to inform you that this command executed successfully.

6. For the DnB2 package, repeat each of the steps starting with step 1.

7. For the DnB3 package, repeat each of the steps starting with step 1. .

(!) Important Note: Before continuing with the installation,you MUST do a FULL Compile to activate the new
changes. If you skip these steps, the installation will generate errors.

Compiling the Application
1. From the Siebel menu, click Tools -> Compile Projects.

2. In the Object Compiler window, select All projects, then click Browse.

3. In the Save As window, select the directory path of your Siebel Server Installation, then click Save.
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4. In the Object Compiler window, click Compile.

5. When the process has completed, go to your computer Start menu, type Run, then type services.msc.
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6. In this order, stop all of the Siebel services:
a. Siebel Management Agent

b. Siebel Management Server

c. Siebel Server

d. Siebel Gateway Name Server

7. Open a Windows Explorer window and navigate to:

C:\sba81\siebsrvr\OBJECTS\ENU\

8. To replace the siebel_sia_srf file with the new versions, rename both fields as follows:

a. Rename siebel_sia.srf — to — siebel_sia_old.srf

b. Rename siebel_sia_new.srf — to — siebel_sia_old.srf

9. Return to the Services window and in this order, start the Siebel services:
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a. Siebel Management Agent

b. Siebel Management Server

c. Siebel Server

d. Siebel Gateway Name Server

Processing the DnB4 and DnB5 Packages

Note: Before you start this section, make sure your repository compiled successfully. For more information,
see "Compiling the Application" on page 4-6.

Complete the steps in this section to each of the last 2 packages — DnB4 and DnB5 — one at a time. In the
following illustration, the steps in darker blue are mandatory. The steps in lighter blue are optional but highly
recommended because a data integrity link is associated with them.

For these steps, we use QUEnt as the CRM enterprise server name and SADMIN as the user name and
password. When you complete these steps, substitute any revised names you used (see "Locating and
Validating the Enterprise Server" on page 4-2).

1. To load package references and verify the load, in the command line, type this command:

deploy_OUEnt load SADMIN SADMIN DnB4

After a few seconds, a message displays to inform you that this command executed successfully.
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2. To create a deployment session for your package and check the status of the session, type this command:

deploy_OUEnt create SADMIN SADMIN DnB4

This creates a deployment record in the database in preparation for the data migration.

After a few seconds, a message displays to inform you that this command executed successfully.

Note: The next two steps are optional. However, it is strongly recommended that you complete
these steps before deploying your package.

3. (Optional): To validate the target enterprise, type this command:

deploy_OUEnt validate SADMIN SADMIN DnB4

This process runs for about two minutes. Although this step is optional, it is strongly recommended, as it
verifies schema versions and that the target agents are online. Verify that the validation succeeds.

4. (Optional): To back up data that will be affected, type this command:

deploy_OUEnt backup SADMIN SADMIN DnB4

Note: Although this backup should run automatically when you enter the copy command, doing it
here will ensure that the backup exists and decrease the time required for the copy command.

5. To deploy the customizations to the target enterprise, type this command:

deploy_OUEnt copy SADMIN SADMIN DnB4

After a few seconds, a message displays to inform you that this command executed successfully.

6. To activate the database WorkFlows and Applets, type this command:

deploy_OUEnt activate SADMIN SADMIN DnB4

After a few seconds, a message displays to inform you that this command executed successfully.

7. For the DnB5 package, repeat each of these steps starting with step 1.

8. When you have completed each package, run a full compile to activate the new changes.

(!) Important Note: Before continuing with the installation,you MUST do a FULL Compile to activate the new
changes. If you skip these steps, the installation will generate errors.
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Applying Table Changes
1. In the Seibel Tools - Siebel Repository window, Siebel Objects area, select Table.

2. In the Name column, select the first table that starts with the letters CX.

3. In the Change Option window, click Apply and then OK.
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4. In the Apply Schema window, Database user and Database user password fields, type your user ID and
password, and then click Apply.

5. For all tables that start with CX, repeat these steps.

Adding the D&B360 Window to the Application
1. In the Siebel Tools - Siebel Repository window, Object Explorer, Siebel Objects area, select

Application.

2. In the Applications window, Name column, select the application for your environment. In this example,
where Siebel Call Center is being used, Siebel Universal Agent is selected.

3. Right-click the application and click Lock Object.
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4. With the application still selected, in the Object Explorer area, select Application, and then Page Tab.

5. In the Page Tab List area, right-click any of the records and select New Record.
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6. Populate the New Record with the following values:

l Screen: DnB Screen

l Text - String Override: D&B360

7. In the Sequence field, type a number not used in the list.

Because this value determines the tab order in the user interface,make sure each record has a unique
value.

8. Run a full compile.
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Chapter 5: Generating the Org ID
Completing the Installation Setup 5-1

Activating the Installation 5-2

Completing the D&B360 Registration 5-4

Completing the Installation Setup
1. To open the Installation Setup window, open a browser window and enter this URL in the address line (or

click it here):

https://dnb360.dnb.com/siebel/Installation/DnBSiebelInstaller.aspx

2. In the Welcome to the Siebel/D&B360 Installation window, fill in this information:

a. Siebel Server Web Service URL

b. Siebel Server User

c. Siebel Server Password

d. Use Secure Web Services (WS-Security UserName Token Profile — click to select.

https://dnb360.dnb.com/siebel/Installation/DnBSiebelInstaller.aspx


3. Click Generate.

A message displays to inform you that Siebel D&B has been installed on your CRM.

Activating the Installation
1. From the D&B360 menu, click About D&B360.

2. In the D&B Licensing area, click Configure.

3. In the D&B Administration Wizard window, click Begin.
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Note: Trial customers—Your 60-day trial period begins at the point of installation, as noted in the
trial terms. If you are not yet ready to configure D&B360,we recommend that you click Cancel and
configure your software when you are ready to start using it. This will allow you to take full
advantage of your trial period.

4. In the D&B360 Terms & Conditions window, click to select the Terms of Agreement, then click Next.
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Completing the D&B360 Registration
1. In the D&B Install Key window, License Information area:

a. In the Install Key field, type the install key that you were provided in the confirmation email.

b. In the other fields, type your information and select your country.

2. In the Siebel Account Information area, type your information, then click Next.

A window displays a message to confirm that you have successfully finished the setup of D&B360 for
Siebel CRM.

3. Click Finish.
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Chapter 6: Installing and Configuring the
Informatica Cloud Secure Agent
This chapter applies only if your account includes batch processing. If it does not, go to this chapter: Establishing
Permissions for Roles Within D&B360.

Preparing for Administration of Batch Jobs 6-1

Installing the Informatica Cloud Secure Agent 6-3

Configuring Connectivity Between the Informatica Cloud Secure Agent and the Siebel Database OBDC 6-6

Creating the OBDC Data Source for Windows Platforms 6-7

Preparing for Administration of Batch Jobs
If your account includes batch processing, before you can schedule and run batches, you need to install and
configure the Informatica Cloud Secure Agent. For information about see "Managing Batches" on page 1.

The first time you open the Siebel CRM application, the system creates and displays an Informatica account,
allowing you to download the secure agent.

1. In the D&B360 Administration window, Batch Processing Setup area, click Batch Setup.



The Batch Setup window includes three areas: User Credentials, New Batch Schedule, and Refresh
Batch Schedule.

Note: To schedule and run a batch, the credentials you use are your Siebel user name and
password. If you want to allow another user the rights to run a batch, you can update that user's
information in the Batch Setup User Credentials area.

2. To allow another user to run batch processing, in the User Credentials area, click Change Credentials.

3. In the D&B360 Update Informatica Connection Credentials window, type the following information, and
then click Update:

l Username

l Password

l Confirm Password

l Database

l Schema

l CodePage
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Installing the Informatica Cloud Secure Agent
You can install the Secure Agent on any computer that is running Linux or Windows and is inside the enterprise
firewall. For more information, refer to the Informatica Cloud hardware requirements.

1. Open a browser window and enter this URL in the address line (or click it here):
https://icosp2.informaticacloud.com/saas

2. Type your User Name and Password to log in to the Informatica Cloud application. If you do not have your
log in information, contact D&B support.
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3. Click the Configuration tab, and in the Agents area, click Download Agent.

Note: Steps 4 to 7 apply to Windows users only.

4. In the installation wizard window, follow the instructions.

5. Select Windows Administrative Tools -> Services.

6. In the Services window, Services (Local) area, stop the Informatica Cloud Secure Agent service.
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7. In the Informatica Cloud Secure Agent Properties window, click the Log On tab

8. In the Log On tab, This account field, make sure the NT account belongs to Administrator group on your
computer, and then type and confirm your password.

9. In the Windows Services window, start the Informatica Cloud Secure Agent service.
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Configuring Connectivity Between the Informatica Cloud Secure
Agent and the Siebel Database OBDC
The Secure Agent connects to Siebel database through DataDirect CLOSED open database connectivity (ODBC)
drivers, which are packaged with the Secure Agent.

1. Obtain Siebel Database connectivity details from the Siebel administrator.

Parameters depend on the database type. The User Name associated with the Database must have
proper permissions to read and write from the Siebel table through an ODBC connection.

Type of Server Required Parameters

SQL l Siebel Database Host Name (or IP address)

l Database Name

l User Name

l Password

l Schema Owner

l Port Number

Oracle l Siebel Database Host Name (or IP address)

l SID

l Service Name

l User Name

l Password

l Port Number

IBM DB2 l Siebel Database Host Name (or IP address)

l Database Name

l User Name

l Password

l Port Number

2. To store your Informatica Cloud Organization ID and Siebel database user name, configure the Batch job
initialization file:
Informatica Cloud Secure Agent\main\rdtmDir\parameters\Dnb360_Initialize_

Siebel.txt.
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3. Log in to Informatica Cloud.

4. Click the Administration tab, and then the Organization tab.

Your Organization ID displays in the Organization Properties area.

The Organization ID displays under Organization Properties.

Creating the OBDC Data Source for Windows Platforms

Note: If you are running in a Linux environment, you must install the iODBC driver manager. For more
information, refer to the Linux documentation for your version of Linux.

1. Log in to your computer as the Administrator.

2. From the Start menu, open the Administrative Tools window.

3. Click Data Sources (OBDC).

4. In the ODBC Data Source Administrator window, select the dBASE Files and click Add.
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— OR —

If you are on a Windows 64-bit platform, click Start -> Run and run the following executable
file: %windir%\SysWOW64\odbcad32.exe. For more information, refer to
http://support.microsoft.com/kb/942976.
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5. To connect to the Siebel database, in the Create New Data Source window, depending on your platform,
select either one of these DataDirect CLOSED Wire Protocol for Informatica drivers:, and then click Finish.

l DB2

l Oracle

l SQL Server

6. To complete the data source configuration, In the OBDC Data Source Administrator window, click the
System DSN tab

7. Select System Data Source name DNB360_Siebel_32, and then click Add.

8. In the ODBC SQL Server Wire Protocol Driver Setup window, click Test Connect.
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9. For more information about the Informatica Cloud, click Help.

10. Click Apply, and then click OK.
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Chapter 7: Establishing Permissions for Roles
Within D&B360
You can specify whether application-specific features such as buttons, links, and check boxes can be turned on
or off for specific roles by enabling or disabling features in the user interface windows .

Setting Permissions for Users
1. From the main menu, select the D&B360 tab.

2. In the Show area, select D&B360 Administration.

Note: After you have completed setting the following features, click Save.

3. In the D&B360 Administration window, Button Configuration area, click the tab whose features you want
to set.

These menu items will display on the user interface



4. In the D&B System Settings area, select the Enable D&B360 Permissions check box.

Note: All features are enabled by default. To remove a feature, clear its check box.

5. In the D&B360 Button Configuration area, to specify which features to display, select the corresponding
check boxes.

— or —

To prevent a button from displaying, clear its check box.
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6. In the D&B360 ROW Annotation Configuration area, to specify which ROW features to display, select the
corresponding check boxes.

— or —

If you want to remove a ROW item, clear its check box.

7. In the Siebel Administration window, User Role Configuration area, select Configure User Roles.

8. In the Role List window, select the role you want to edit and click Edit.
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9. In the Role Management window, Has Access column, select the check box for each role you want users
to have permissions for.

— or —

Clear the check box for roles you want to block from the user.
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10. In the Role List window, click Save.

11. For roles other than User Roles that you want to configure, repeat these steps (see this step on page 7-3.)
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12. In the Stare and Compare Configuration window, Select Fields for Update in Stare and Compare area,
select the check boxes for the fields you want to display, and then click Save.
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Understanding Key Features of D&B360 Batch Jobs 8-2

Record Eligibility 8-2

Confidence Code Threshold Facts 8-2

Validating D-U-N-S Numbers 8-2

Scheduling Batch Jobs 8-3

Scheduling New Batch Jobs 8-3

Scheduling Refresh Batch Jobs 8-4

Overview of Batch Jobs
Two batch jobs are available through D&B360:

l New Batch — Use to associate existing Siebel accounts with a valid D-U-N-S record. New Batch chooses
accounts from Siebel and sends the account name and address to D&B for potential cleanse, match,
and append processes. After D&B returns the batch records, the accounts in Siebel are associated with
a valid D-U-N-S number.

l Refresh Batch — After Siebel accounts are associated with a D-U-N-S number, a Refresh Batch is used
once a month, or once a week, to refresh the D-U-N-S data stored in D&B360 Siebel tables.



Understanding Key Features of D&B360 Batch Jobs
The three key features of D&B360 Batch jobs are:

l Record Eligibility

l Confidence Code Threshold Facts

l Validating D-U-N-S Numbers

Record Eligibility

Every record picked for New Batch processing goes through a data quality check procedure. To pass this quality
check, a record must have a Company Name and one of the following:

This field: Phone

2 of these fields: Billing City, Billing State, Billing Postal Code

5 of these fields: Billing Address, Billing City, Billing State, Billing Postal Code, Billing Country,
Phone

Note: If none of the three criteria is met, the records will get pushed to the Admin Review List.

Confidence Code Threshold Facts

l The range of Confidence Code is: 1 to 10

l Any number above 8 is considered to result in accurate match records.

l The setting can be adjusted by a D&B360 Administrator in the Batch Setup screen.

Records from D&B that fail to meet the defined Confidence Code Threshold are moved to the Admin Review List.
They are not automatically re-processed in the next batch run. As the Administrator, you must manually process
these records.

Validating D-U-N-S Numbers

An event such as a merger or acquisition can result in changes to the D-U-N-S number for a record.

Note: A Recertified D-U-N-S has occurred when we send records to D&B in a Refresh Batch job, and the
returned records have a new D-U-N-S Number.
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In the case of a Merger or Acquisition, re-certified D-U-N-S records will be updated within the D&B360 table with
the following:

l Re-cert reason code

l Re-cert description

l DATS date when the new DUNSNumber was assigned

Scheduling Batch Jobs
Each batch job has its own distinct schedule:

New Batch When you are ready to execute a batch job for the first time, you must run
the New Batch Job.

Refresh Batch You can run Refresh Batch only after you have run New Batch at least once.

Scheduling New Batch Jobs

Make sure that you type your user credentials before you schedule a new batch. Complete the following:

1. In the New Batch Schedule area, enter the Start Time (date and time) for a new batch.

2. In the Confidence Code field, select from 1 to 10. The default is 8. We recommend using a relatively high
confidence code.

3. In the Repeat Frequency area, use the menu to specify how often you want to run the batch job, either
Does Not Repeat, Daily, Weekly, or Monthly

4. Click Save Batch Settings.
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Repeat Frequency

Does Not
Repeat

Daily Weekly Monthly

Run the
Task

Select Start
Time and Date

Select Every day or
Every weekday

Select the day
of the week

l Select Day of the month, or
l Select the first, second, third,
fourth, or last day of every
month

Repeat
Options

N/A l Select Repeat indefinitely or
l Repeat until and choose the date and time.

Note: Depending on the number of records a batch job is processing, results will be available 24 to
72 hours after you submit the job. Smaller files typically take 24 to 48 hours to finish processing.

Scheduling Refresh Batch Jobs

Make sure that you type your User Credentials before you schedule a refresh batch. Complete the following:

1. In the Refresh Batch Schedule area, enter the Start Time (date and time) for a refresh batch.

2. In the Confidence Code field, select from 1 to 10. The default is 8. We recommend using a relatively high
confidence code.

3. In the Repeat Frequency area, use the menu to specify how often you want to run the batch job, either
Does Not Repeat, Daily, Weekly, or Monthly

4. Click Save Batch Settings.
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Chapter 9: Reviewing Activity Logs, the Admin
Review List, and D&B360 Reports

Expanding Your Reporting Options 9-1

Viewing Callout Logs 9-2

Accessing Activity Logs and the Admin Review List 9-3

Viewing and Processing Failed Batch Records in the Admin Review List 9-5

Reviewing D&B360 Reports 9-7

Duplicate DUNS Report 9-7

Using the Recertified D-U-N-S Report 9-8

Expanding Your Reporting Options
In the Siebel CRM, you can design reporting features based on specific information. D&B360 includes two fields
that you can add to a record — the Association Date and the Association Status. These are shown in the following
illustration.



Viewing Callout Logs
The callout log tracks all web service definition language (WSDL) calls that occur between your CRM system and
D&B.

1. In the D&B360 window, Siebel Administration area, click D&B360 Call Out Logs.

2. In the D&B Callout Log column, select the transaction ID link for the Callout Log you want to view.

In the following example, the callout log for a DNB Refresh Check is selected.
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An example of the information that displays for a callout log is shown in the following illustration. Callout
logs often help Customer Support resolve any issues about that operation.

Accessing Activity Logs and the Admin Review List
1. In the D&B Administration window, scroll down to the Batch Setup area.

2. Click Batch Setup.

3. In the Batch Setup window, click the logs you want to view:

l To monitor new batch jobs, click New Batch Activity Logs.

l To monitor refresh jobs, click Refresh Batch Activity Logs.

l To review records that process only manually, click Admin Review List.
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4. To return to the Batch Setup area after you have opened a specific report, click Back.

In both New Batch and Refresh Batch Activity Logs, two entries display for each job submitted:

l Submit type that displays the number of accounts sent to D&B.

l Receive type that displays the number of accounts D&B returns.

You can use pagination and sort capabilities to quickly locate the information you are looking for. The activity logs
columns are described in the following table:

Column Name Displays …

Start Time Job start time.

End Time Job end time.

Status l Submit task type for records sent to D&B.

l Receive task type for records returned from D&B.

Total Accounts Processed Number of records involved in a Submit or Receive task.

# of Accounts Updated Number of accounts sent to D&B for the Submit task type. For the
Receive task type, displays the number of records that were
updated with D&B data in the D&B360 table.

# Accounts that Failed DQ
Check

Number of records that failed initial data quality check and only for
New Batch Submit type task.

# Accounts below Confidence
Code

Number of records with a confidence code below the organization’s
set threshold value and only for a New Batch Receive type task.

# Failure Rows Number of errors found.

Error Message Last error message.

# Records Refreshed Number of records that were refreshed with D&B data in the
D&B360 table and only for a Refresh Batch Receive type task.

# Recertified Records Number of records that had new D-U-N-S Numbers assigned and
only for a Refresh Batch Receive type task.

D&B360 Administration and Installation Guide for Siebel CRM Chapter 9: Reviewing Activity Logs, the Admin Review List, and
D&B360 Reports

9-4 Dun & Bradstreet © 2013



The following illustrations show examples of the batch logs:

Viewing and Processing Failed Batch Records in the Admin Review
List
Accounts without a D-U-N-S Numbers are batched and sent to D&B for matching with D&B’s D-U-N-S data. Some
accounts cannot be sent because they don’t meet 80% completeness. These accounts are listed in the Admin
Review List for review and resolution.

When the information is returned from D&B, most of the accounts will have been matched with D-U-N-S
Numbers. Some accounts will be sent to the Admin Review List for one of the following reasons:

l They were unable to be matched.

l They were matched, but the confidence code is below the default.

Whenever accounts are on the Admin Review List, you must review the information and correct it so that these
accounts can be successfully processed.
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Refresh batch results can also produce items that you must manually review and resolved. For example, you
need to change or accept the modified data.
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Reviewing D&B360 Reports
The two D&B360 reports that are valuable in the review and resolution of some common situations include:

l Duplicate DUNSReport

l Recertification Report

Duplicate DUNS Report

If more than one account with the same D-U-N-S Number exists, it is listed on the Duplicate DUNS report.7

The tier level of your license agreement determines the type of access you have:

Tier 1 Access to report, but unable to merge accounts.

Tier 2 Access to report, and can merge accounts.

Tier 3 Access to report, can merge accounts, and can prevent duplicates from being created
at all (see "Considerations for Administrators " on page 2-2).

Note: The tier level of your license agreement determines the type of access you have: Tier 1: Access to
report, but cannot merge accounts.

To resolve duplicates, you need to review the information in each of the duplicates and then:

l Decide which one is the master – that is, which one should be the primary selection.

l Select an account with information you want to merge into the master.

Note: If you have three or more accounts with the same D-U-N-S Number, you can merge the
information frommore than one account into the master. However, you must do the merge
operations one at a time since the merge function merges information from two sources at a time.
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Using the Recertified D-U-N-S Report

Periodically, a company's information will change, which triggers a change in the D-U-N-S Number. Use this report
to identify these issues, so that you understand – and if necessary – can modify your account information.
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Frequently Asked Questions (FAQ's)

Question Answer

Can D&B360 for Siebel CRM be
installed once and accessed by multiple
instances (or ORGs) of Siebel CRM?

No. During the installation, the Siebel CRM ORG ID is used
to create a unique key to access our DaaS platform. A
separate D&B360 for Siebel CRM installation will be
needed for each Siebel CRM instance (or ORG) that needs
access to D&B360.

What steps should I take if our existing
implementation of D&B360 for Siebel
CRM has expired?

Follow these steps to re-install D&B360 after it has expired:

1. Verify that the existing D&B360 application has expired.

2. If expired, contact D&B360 Support and ask them to re-
activate your Siebel CRM ORGID (Administration Setup /
Company Profile / Company Information)

Note: If there’s a reason D&B Support is unable to
comply immediately, they will let you know at that time
and assist you in getting the issue resolved as quickly
as possible.

3. Install the latest D&B360 application

Dun and Bradstreet is committed to a high level of customer satisfaction. An efficient support process is
combined with a communication service level agreement to give our customers quality support.



The communication SLA (Service Level Agreement) is as follows:

Initial Response The maximum timeframe for initial response for all inbound issues is 4
hours.

Ongoing
Communication

SLA Determined with the customer.
Based on mutual agreement of the severity of the issue.

The communication SLA is based on normal business hours, which are considered to be:

l 8 A.M. – 6 P.M. local time, Monday through Friday

l Excluding D&B holidays

To submit a ticket, go to this URL: http://dnbus.force.com/support?prod=dnb360. You will be prompted to
enter your e-mail address and then fill out a form.

Tables Created During Installation
Installation of D&B 360 creates the following tables in your database:

Table Name Purpose Type

CX_ACCOUNTXT_X An extension of the standard Account table. Holds D&B record
related data.

Extension

CX_CCODE Holds the Confidence code configuration for Batch process. Batch

CX_DNBADMINT Holds failed record details resulting from the batch jobs Batch

CX_DNBCODE Holds D&B360 for Siebel installer version information. Installer
Data

CX_DNBCOMPANY Holds a copy of the D&B Company Data and is joined to the
Siebel Account table through the CX_DNBCOMPANYXR table.

Data

CX_DNBCOMPANYXR Holds the relationship between the Account and D&B Company
Record.

Xref

CX_DNBCONTACT Holds a copy of the D&B Person Data and is joined to the Siebel
Contact table through the CX_DNBCONTACTXR table.

Data

CX_DNBCONTACTXR Holds the relationship between the Contact and D&B Person
Record.

Xref

D&B360 Administration and Installation Guide for Siebel CRM Appendix A: Troubleshooting
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CX_DNBOPPTY2XR Holds the relationship between the Opportunity and the D&B
Contact Record.

Xref

CX_DNBOPPTYXR Holds the relationship between the Opportunity and the D&B
Company Record.

Xref

(!) Important Note: If you cancel the product license or it expires, you must remove or truncate all data in
the tables of type Data. These tables hold a copy of D&B’s data within the CRM system.
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